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Lag et nytt EndNote-bibliotek

Nar du apner EndNote Desktop for fgrste gang, far du en gra skjerm med en menylinje pa toppen.

For & ta programmet i bruk, trenger du et bibliotek, som kan opprettes ved & klikke pa File > New. Gi

biblioteket et navn og klikk Save. Det nye biblioteket dpnes automatisk.

=  For a apne et eksisterende bibliotek, ga til File > Open Library... og finn frem biblioteket ditt.

= Et EndNote-bibliotek bestar alltid av en EndNote-fil med bibliotekets navn (f.eks. Endnote) og en
mappe med samme navn (Endnote.Data). De to delene ma alltid lagres sammen for at biblioteket
skal fungere problemfritt.

=  For a lagre en sikkerhetskopi av biblioteket i en komprimert fil: G til File > Compressed Library
(.enlx), og velg hva som skal veere med i biblioteket.
Klikk pa OK for a lagre filen pa gnsket sted.

Layout

Apner du et nytt bibliotek, vil skjermbildet se slik ut:

@ EndNoteX8 File Edit References Groups Tools Window Help ) = [J 53%m) to

[ BN @ “ New.enl
EEEEE O CISE '

My Library v [Rec... | @ | Fortatter ~lA | Tittel ] e 4 R

There are no PDFs
2 Al References @ No Reference Selected |~ - " o

reference

THOMSON REUTERS Q. Search Library

& configure Sync...
4D Recently Added
B) unfiled

"E" Trash

momer @ ® ®

¥ Find Full Text

HiB-Harvard versjon 1 v ]

No References Selected

Verktgylinje: Se lenger nede for beskrivelse av funksjoner

Referanseoversikt

Gruppepanel: Viser gruppene som biblioteket er inndelt i

Referansepanel: Visningsfelt for markert referanse

Visningsvalg for referansepanel: Referansedetaljer, forhandsvisning i henhold til valgt stil og

vedlegg (vanligvis fulltekst i PDF-format)

Layout: Velg posisjonering og utforming av referansepanelet

7. Kolonneoversikt for referanselisten: Kolonnene som vises kan endres med Ctrl-klikk, eller ved
a ga til EndNote X8 - Preferences - Display Fields

8. Valgmeny for referansestiler

AR e

o



Eksempel pa bibliotek i Bottom — Split layout:

000 “ yveiledning.enl
2 KRlI[E] B f,ré'TiG? [} HOMSON REUTERS =B M mv
My Library v | Rec... | @ | Forfatter [Ar | Tittel | Type | Journal/secondary Title
T rousson Viaus roer “uve FunmUTarY ISGUUTT > = or
& All References £ |20 Holland, F.; Bragg, R. 1995  Fluid Flow for Chemical and Process Engineers Book Chemistry
@ Configure Sync... 74 Hov, Jo 1993  Avtalerett Book
£ Recently Added 58 Haberg, Liv Ingrid Aske 2016  Didaktikk i ein barnehagekontekst Journal Article Barnehagefolk
ocentl a 1zzo, Angelo A; Ernst, Edzard 2009 Interactions between herbal medicines and prescribed dru... Journal Article Drugs
B unfiled @ 52 @ Jacobs, David M.; Shaver, Amy 2017 of and from aureus... Journal Article American Journal of Infectiol
T Trash @D | Ji, Y;; Chen, S.; Xiang, B.; LI, K.; Xu, Z;; Yao, W.;... 2017 for the of he... JournalArticle IntJ Cancer
55 Kim, Lee, Kim, W... 2016  Evaluation of lifting efficiency of double-cage C Proc... 33rd
¥ Unfiled Groups 61 Klaebo, Lars Gunnar 2017  Myocardial strain-analysis Journal Article Hijerteforum
E_, Bygg e |36 Klima- og miljodepartementet, 2017 av for for Doc...
2 deling (5 ) 38 Kunnskapsdepartementet 2011 for innhold og Report
B Erekiro 16 Lai, Goh 2010  Follow the Chemistry : Lure, Lore and Life - An Autobiogra... Book Chemistry
i Ele 66 @ \Lands, Larry C; Stanojevic, Sanja 2016  Oral non-steroidal anti-inflammatory drug therapy for lung... Article of Systel
2 HvL [ 6] 13 @ U, D.W.; Zhou, J. J.; Zhang, Z. B.; L, L. J.; Tian,... 2017 low-p! CO2 capture of N-do... Journal Article Carbon
B Kiemi D | Lolas Hamameh, S.; Renbaum, P.; Kamal, L.; D... 2017  Genomic analysis of inherited breast cancer among Palest... Journal Article Int J Cancer
Blj Medisin @ |59 Maao, Thobias 2016 i zet forsok med adapt... Journal Article Norskleeraren
18 Mathis, Terry L.; Galloway, Shawn M. 2013  Chemistry Book
¥ My Groups a7 Meng, Y.; Lin, Z. M.; Ge, N.; Zhang, D. L.; Huang,... 2015 Ursolic acid induces apoptosis of prostate cancer cells vi... Journal Article American Journal of Chinese
g o = Mavar K _C. 2017__BIIL PARTI: OGY_PATHO_lournal Articla Evnart Rav Raenir Mad
B Exsampel 2 +) (Joumal Article B - FR A O% > 7
* New Smart Group (3]
Author .
2 Jacobs, David M.
¥ Find Full Text Shaver, Amy
Year
2017
Title
F of and from aureus ia among
patients in the United States, 2009-2012
HiB-Harvard versjon1___ ¢
Jacobs, D.M. og Shaver, A. (2017) of and from
aureus pneumonia among hospitalized patients in the United States, 2009-2012.
American Joumnal of Infection Control, 45 (4), s. 404-409.
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Synkronisering av biblioteket mot EndNote Online
Deling av biblioteket

Meldinger om nylige forandringer i biblioteket
Sek etter fulltekst online

Finn oppdateringer for referansen

Legg til en ny referanse manuelt

Lokal modus

Online-modus

Blandet lokal + online-modus

Kopier referansen fra online-sgket til det lokale biblioteket
Sett inn markerte referanser i Word

Formater litteraturlisten i en bestemt stil

Ga til Word
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Legg nye referanser til biblioteket

Det finnes flere mater a samle referanser i EndNote. Man kan eksportere referanser fra fagdatabaser
ved a laste ned en referansefil, man kan sgke i databaser via EndNote, eller man kan legge inn
referanser manuelt.

Eksporter referanser fra en database

For a eksportere referanser fra en fagdatabase, fglger du som regel disse stegene:

1) Sgk etter et emne i en relevant database

2) Kryss av for en eller flere aktuelle artikler i trefflisten

3) Klikk pa en knapp eller lenke med navnet cite, send to, download eller export.
4) Last ned referansene i EndNote- eller RIS-format.

5) Klikk pa filen i nedlastinger eller dra den til EndNote-ikonet for & importere

Ting kan ga galt under import av referansene. Opplysninger kan havne feil i felt, og de kan ogsa vaere
registrert feil. Du bgr derfor alltid korrekturlese referansene du har lastet inn.

Nedenfor finner du to eksempler for referanseeksport til EndNote fra Oria og Google Scholar.
Se hvordan du eksporterer referanser fra andre databaser pa bibliotekets EndNote hjelpesidene
(«Eksport av referanser fra databaser til EndNote Desktop»).

Eksport fra Oria:
1) Sgk opp referansen du vil overfgre

2) Klikk pa fanen Send til
3) Klikk pa EndNote

Metode og oppgaveskriving
7" % Olav Dalland 1940-
7 2017
@ Tilgjengelig fra Hegskolen i Bergen

Finn og bestill  Detaljer ~ Omtaler & tagger  Virtuell hylle Send til

Bok

» Leggilagrede treff
» E-post
o Skriv ut
» Permalenke
+ Referanse

« HefiVorks

« Delicious
» Eksport RIS
» EndNote Web
» Export BibTeX

4) Klikk OK i vinduet som apner seg (du trenger ikke a forandre innstillingene)
5) Lagre filen og/eller apne den med EndNote
6) Korrekturles den overfgrte referansen

= For aredigere referansen, markerer du den i biblioteket for a dpne den i referansepanelet.
Klikk deg inn i feltet som skal redigeres. Klikk pa File = Save (cmd+S) for & lagre endringene.



# v (Book

Author
Dalland, Olav

<>
od

Year
2017

Title
Metode og oppgaveskriving

Series Title
Metode og oppgaveskriving for studenter

Place Published
Oslo

Publisher
Gyldendal akademisk

Edition
6. utg.

ISBN
978-82-05-50070-9

= | eksempelbildet over star en referanse eksportert fra Oria til EndNote. | referansen kom
utgaveinformasjonen med pa norsk (utg.). | EndNote legger referansestilene automatisk til
utg. pa norsk eller ed. pa engelsk, og dette skal derfor ikke vaere med i referansen. | feltet
Edition skal det bare sta selve tallet. Feltet Series Title skal vaere tomt.

= For avelge om tomme felt skal vises i referansepanelet, klikk pa tannhjulsymbolet
i hjgrnet av referansepanelet og aktiver/deaktiver Show Empty Fields.

Eksport fra Google Scholar:

1) Sgk opp referansen du gnsker a overfgre
2) Klikk pa Referanse/Cite

The effect of corrosion on the structural reliability of steel offshore structures
RE Melchers - Corrosion science, 2005 - Elsevier

This paper considers essential theoretical concepts and data requirements for engineering

structural reliability assessment suitable for the estimation of the safety and reliability of

corroding ships, offshore structures and pipelines. Such infrastructure operates in a harsh

Sitert av 130 Beslektede artikler Alle 7 versjoner Web of Science: 68' Referansel Lagre

3) Idet nye vinduet, klikk pa EndNote

Referanse

Kopier og lim inn et formatert sitat, eller bruk en av linkene for & importere til en
bibliografibehandler.

MLA - Melchers, Robert E. "The effect of corrosion on the structural reliability of steel
offshore structures.” Corrosion science 47.10 (2005): 2391-2410.

APA - Melchers, R. E. (2005). The effect of corrosion on the structural reliability of
steel offshore structures. Corrosion science, 47(10), 2391-2410.

IS0 690 MELCHERS, Robert E. The effect of corrosion on the structural reliability of
steel offshore structures. Corrosion science, 2005, 47.10- 2391-2410.

BibTeX I EndNotel Reflan  RefWorks

4) Lagre filen og/eller apne den i EndNote
5) Korrekturles den overfgrte referansen



Sek i fagdatabaser via EndNote (Online Search Mode)

| Online Search Mode kan du sgke etter referanser direkte i EndNote, uten at du ma apne databasen
i nettleseren din. En del sgkefunksjoner fra fagdatabasen vil mangle, sa Online Search Mode
anbefales bare for a sgke opp bestemte referanser, ikke for selve litteraturspket.

1) Bytt til Online Search Mode G

2) Velg databasen i sidepanelet som du vil sgke i (f.eks. PubMed, Web of Science, LOC)
Klikk pa more... om du ikke ser gnsket database i listen

3) Fyll ut et eller flere sgkefelt og klikk pa Search

4) Kopier referansene til biblioteket ved & markere dem i trefflisten og klikke pa

Copy to Local Library

= NB: Mange databaser krever palogging, og vil veere utilgjengelige for bruk.

Legg inn referanser manuelt
Referanser for bgker og tidsskriftsartikler kan du stort sett eksportere fra Oria eller fagdatabaser til

EndNote. For en del andre kilder er det ngdvendig a legge inn referansen manuelt, f.eks. nettsider,
avisartikler, lover og forskrifter, rapporter, retningslinjer eller bilde- og lydmateriale.

Ga til References > New Reference (cmd+N) eller klikk pa EH

1)

2) Velg passende Reference Type og fyll ut de ngdvendige feltene
3) Lagre referansen ved a ga til File = Save (cmd+S)

4) Lukk referansen. Referansen finner du igjen under All References

For a finne passende Reference Type for kilden du bruker og for a sjekke hvilke felt som ma fylles ut,
kan du se pa eksempelsamlingene pa bibliotekets EndNote-hjelpesider.

Noen eksempler pa referanser som er lagt inn manuelt:

= Lov

<>
-

ﬁ- v [Legal Rule or Regulation

Author
Avhendingslova,

Year
1992

Title
Lov av 3. juli 1992 nr 93 om avhending av fast eiendom

URL
https://lovdata.no/dokument/NL/lov/1992-07-03-93

= Nettside



L v | (Web Page

<>
c

Author
Helsedirektoratet,

Year
2017

Title
Ngkkeltall: Spesialhelsetjenesten del 2

Place Published
Oslo

Publisher
Helsedirektoratet

Access Date
19. mai 2017

Last Update Date
23. februar 2017

URL
https:/helsedirektoratet.no/statistikk-og-analyse/nokkeltall/nokkeltall-for-
spesialisthelsetjenesten/nokkeltall-spesialisthelsetjenesten-del-2

Standard

¥ v (Standard ¢l

Institution
Standard Norge,

Year
2015

Title
Eurokode 3: Prosjektering av stalkonstruksjoner -
Del 1-1: Allmenne regler og regler for bygninger

Place Published
Oslo

Publisher
Standard Norge

Document Number
NS-EN 1993-1-1:2005+A1:2014+NA:2015

NB: Feltet Author fylles vanligvis fylles ut i formen:

Etternavn, Fornavn

Organisasjonsnavn som bestar av flere enn ett ord ma fgres inn med komma etter, for 8 unnga at
navnet inverteres som et personnavn. For eksempel:

Hggskulen pa Vestlandet,



EndNote og Word

Nar EndNote er installert, vil du finne en verktgylinje i Word med navn «EndNote X8». Denne bruker
du til a sette inn referanser fra biblioteket ditt, velge gnsket referansestil og til a tilpasse
referansehenvisningene i teksten.

Sett inn referanser
1) Sett markgren der du gnsker referansen, og klikk Insert Citation i EndNote-verktgylinjen

i‘ : F;’l Do

Go to EndNot = 4 5 Tools
|”| @ Q0SNG Style: { HiB-Harvard versjon 1 ,] in. Categorize References S0
Q | J E?} Edit & Manage Citation(s)
— e = Bibliography v l Instant Formatting is Off 'l
Citation E", Edit Library Reference(s)] L_" SERE g e Help

<

Insert

i

delse e gje 0 EndNote X8

2) Sek etter referansen du vil sette inn, f.eks. pa forfatter, ord i tittel eller arstall.

@0 e EndNote X8 Find & Insert My References
|Find Citation: | Q-dalland X))
Author ~ | Year | Title
Dalland 2012 Metode og oppgaveskriving for student...

Reference Type: Book

Record Number: 2

Author: Dalland, Olav

Year: 2012

Title: Metode og oppgaveskriving for studenter
Series Title: Metode og oppgaveskriving

Place Published: Oslo

Publisher: Gyldendal akademisk

Edition: 5. utg.

ISBN: 9788205423985
@ Cancel | Insert |+ l
Library: My EndNote Library.enl 1item in list

3) Med et klikk pa Insert setter du inn en henvisning i teksten, og referansen blir lagt til
i litteraturlisten pa slutten av dokumentet.

=  Huvis du bruker en forfatter-arstall-stil, kan du i nedtrekksmenyen av Insert velge om du

vil ha bade forfatter og arstall (Insert),
bare arstall (Insert & Exclude Author) eller bare L

forfatter (Insert & Exclude Year) med i teksten. Insert

Du kan ogsa bare legge til referansen i litteraturlisten Insert & Display as: Author (Year)
. ' T Insert & Exclude Author

(Insert in Bibliography Only), eller sette forfatteren et & Ealiide Ve

utenfor parentes (Insert & Display as: Author (Year)). Insert in Bibliography Only




= Alternativ kan du bytte til EndNote Desktop, markere referansen(e) du vil sette inn, og

klikke symbolet E .

Velg referansestil og design av litteraturlisten

= Velg referansestil i stilmenyen.
= Klikk Select Another Style... for a finne installerte stiler som ikke er med i listen.

@ M d =) < Dokument1

Hjem Sett inn Utforming Oppsett Referanser Masseutsendelser Se gjennom Vis EndNote X8

r] N l Is v

73 @ S tEndiion [Style: [ HiB-Harvard versjon 1 C] Eﬂ- Categorize References 'I Juols

Q Edlt & Manage Citation(s)
Insert =\ Bibli hy v [ Instant F tti ff v ] [__—]
Citation [: Edit Library Reference(s)] I._,| ibliography . nstant Formatting is O 0 e

= Du kan tilpasse font, skriftstgrrelse, innrykk, linjeavstand og avstand mellom
referansene i litteraturlisten under Blibliography = Configure Bibliography... > Layout

EndNote X8 Configure Bibliography

{ Format Bibliography [ Layout }

Font: [ Calibri ¢]  size: 2 [v]

Bibliography title:

Start with bibliography number:

First line indent: Line spacing: [ Single C]

Hanging indent: Space after: [ None 2l
@ [ Cancel ] [ OK ]

Rediger og slett henvisninger

For a redigere referansene i et Word-dokument, bruker du funksjonen Edit & Manage Citation(s).
NB: Ikke skriv direkte inn i formaterte EndNote-felt! Det vil fgre til at endringene tilbakestilles
eller at formateringen gar tapt.

@ M d (= Dokument1

Hjem Sett inn Utforming Oppsett Referanser Masseutsendelser Se gjennom Vis

rl to EndNot I =] Tools ¥

73 t‘ E ot Endhon Style: [HIB Harvard versjon 1 ] in» Categorize References v

Q F‘?, Edit & Manage Citation(s)]
S— _-.—

LE’[ Bibliography ¥ ’. Instant Formatting is Off ¥ ] e Help

Insert = —
Citation [-; Edit Library Reference(s) y




= Det apnes ett nytt vindu med en oversiktsliste over referansene i dokumentet.

o e EndNote X8 Edit & Manage Citations
Citation ~ | Count | Library
¥ (Ciesielski, 1999)
Ciesielski, 1999 #21 1 Traveling Library
¥ (Ruer, 2013) Cc/D
Ruer, 2013 #22 i Traveling Library I
¥ (Myhre, Marshburn & Toverud, 1989, s. 48)
Myhre, 1989 #23@48 1 Traveling Library
¥ (Aalborg, 2015; Gjems-Onstad, 1984)
+ Gjems-Onstad, 1984 #... 1 Traveling Library
4+ Aalborg, 2015 #26 1 Traveling Library
¥ (Fischer, 2016; Mzeland, 2016)
L
{ Edit Citation = Reference }
| Format: [ Default 2] B
Prefix: I |
Suffix: | |
[Pages] A| |
@ @) [ cancel ] [ ok ]
Totals: 24 Citation Groups, 30 Citations, 30 References

A) Legg til sidetall

= | feltet Pages kan du legge inn sidetall for henvisningen i teksten. Dette gjelder for den
aktiverte henvisningen, og vil ikke pavirke andre instanser.

= Noen stiler stgtter ikke sidetall direkte, og da ma du legge det inn med Suffix istedenfor
Pages.
Pages = Skriv inn bare tallet
Suffix = Skriv inn «, s. sidetall»

= Klikk OK nar du er ferdig med redigering av referansen.

Eksempel:
F@r redigering: (Myhre, Marshburn & Toverud, 1989)
Etter redigering: (Myhre, Marshburn & Toverud, 1989, s. 48)

B) Fjern forfatternavn eller arstall fra henvisning in teksten

= Under Format kan du velge om du vil ha forfatter og arstall med
i referansehenvisningen.

Format: v Default
Display as: Author (Year)
Prefix: Exclude Author
Exclude Year
Suffix: Exclude Author & Year
Show Only in Bibliography

= Klikk OK nar du er ferdig med redigering av referansen.



C) Legg til en referanse pa samme sted som en eksisterende

= Klikk pa tannhjulet og velg Insert Citation.

¥ (Ruer, 2013)

Ruer, 2013 #22 1 Traveling Library
¥ (Myhre, Marshburn & Toverud, 1989, s. 48) Edit Library Reference
Myhre, 1989 #23@48 1 Traveling Library | (RemeveCitation

Insert Citation

¥ (Aalborg, 2015; Gjems-Onstad, 1984) Update From My Library...

= Klikk OK nar du er ferdig med redigering av referansen.

D) Slette referanser

= Klikk pa tannhjulet og velg Remove Citation.

¥ (Ruer, 2013)
Ruer, 2013 #22 1 Traveling Library
¥ (Myhre, Marshburn & Toverud, 1989, s. 48) Wence
ein
Myhre, 1989 #23@48 1 Traveling Library | T
¥ (Aalborg, 2015; Gjems-Onstad, 1984) Update From My Library...

= Klikk OK nar du er ferdig med a redigere referansen.
= Henvisningen er na slettet fra dokumentet. Referansen ligger fremdeles i biblioteket.

Oppdatering, formatering og konvertering av referanser i Word
A) Oppdatere referanser

Nar du redigerer referanser i EndNote-biblioteket, ma de oppdateres i Word-dokumentet.
Dette gjgres automatisk innimellom, men kan gjgres manuelt ved a klikke pa Bibliography >
Update Citations and Bibliography.

Hjem Sett inn Utforming Oppsett Referanser Masseutsen

Go to EndNot: 4
|,,(1| ]E® Do Ence el Style: [HiB-Harvard versjon1¢] @.Categor

@ Edit & Manage Citation(s) ]
= Bibli hy v Instant F
Citation [E Edit Library Reference(s)‘ D il il

Insert
[ Update Citations and Bibliography]

Configure Bibliography...

B) Avformatere referanser

Skal du flytte tekstavsnitt som inneholder EndNote-referanser eller sla sammen flere
dokumenter, bgr du avformatere referansene fgr du klipper og limer. Da vil Word arbeide
raskere. | sjeldne tilfeller kan kopiering av formaterte EndNote-referanser medfgre feil.

10



= Klikk pa Tools > Convert to Unformatted Citations

Hjem Sett inn Utforming Oppsett Referanser Masseutsendelser Se gjennom Vis EndNote X8

Go to EndNote . S Tools ¥
|,b| I - Style: I HiB-Harvard versjon 1 ,‘ @ Categorize References ']

@ Edit & Manage Citation(s) J

Citation [E&. Edit Library Reference(s)] D Dillograpty nEant Fotmating s on

| Convert to Unformatted Citations)

Convert to Plain Text

Export Traveling Library

Dette fgrer til at litteraturlisten forsvinner, og henvisningene erstattes av EndNote-koder.

(Myhre, Marshburn & Toverud, 1989, s. 48) = {Myhre, 1989, Patologi@48}

Klikk pa Bibliography = Update Citations and Bibliography for a fa referansene tilbake til
formatert form.

C) Konverter referansene til tekst

Det er mulig a opprette et Word-dokument hvor forbindelsen til EndNote er brutt. Her kan
du gjgre siste finpuss i referansene. Dette burde vaere det siste man gjor fgr eventuell lagring
som PDF eller fgr man sender dokumentet fra seg.

NB: Ta vare pa det opprinnelige dokumentet, der EndNote-kodene er intakt. De kan ikke
gjenopprettes i det nye dokumentet.

= Klikk pa Tools = Convert to Plain Text

Hjem Sett inn Utforming Oppsett Referanser Masseutsendelser Se gjennom Vis EndNote X8

rl Go to EndNote - P S Tools ¥
,b @ Style: IHiB-Harvard versjon 1 ,‘ Ec& Categorize References ']

@ Edit & Manage Citation(s) J

F_ T = [] T ‘ Convert to Unformatted Citations
- logra v nstant Formattingis On v
Citation “?u, Edit Library Reference(s)] Pt 2RO RN, ing

Insert
[ Convert to Plain Text]

Export Traveling Library

Organiser EndNote-biblioteket

Organiser biblioteket i grupper
Du kan holde orden i biblioteket ved a legge referansene i grupper.
= Custom groups:

For & lage en ny gruppe, ga til Groups = Create Group. Den nye gruppen finner du igjen under
My Groups i gruppepanelet. Du kan gi et navn til gruppen ved 3 klikke sakte pa den to ganger.
For a legge en referanse i gruppen, drar du referansen fra listen i All References til gruppen i
gruppepanelet.

=  Smart groups:

Smartgrupper samler referansene etter gitte kriterier. For a lage en ny smartgruppe, ga til
Groups = Create Smart group. Det apnes et nytt vindu i det du kan velge et navn for gruppen og
sette kriterier for referansene. Du kan f.eks. sgke etter forfatter, arstall, opprettelsesdato,
database eller ngkkelord. Klikk Create for 3 opprette smartgruppen.
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Smart Group
Smart Group Name: iNew Smart Group
( Author Sl Contains C][ ]EJ
(and 3)( Year ) (_Contains __3)| (€3]S
(and 2)( Title 2)( Contains CJ[ ]@
(JJ Match Case (] Match Words

Slette dubletter

For @ unnga stgy fra referanser som er importert flere ganger, kan du sjekke biblioteket ditt for
dubletter. G4 til References = Find Duplicates. Finnes det dubletter i biblioteket ditt, apnes det et
vindu der du kan sammenligne dublettene. Velg referansen du vil beholde ved & klikke pa Keep This
Record.

Legg til fulltekst

Har du lagret fullteksten til en artikkel, kan du knytte den til referansen i EndNote-biblioteket ditt.
Legg ved en PDF ved 3 klikke pa den aktuelle referansen i EndNote og a klikke pa binders-symbolet i
referansepanelet.

(¢ ~] O s

There are no PDFs attached to this reference

Finn fulltekst pa nett

EndNote kan ogsa spke opp fulltekst pa nett. EndNote gjgr da et oppslag basert pa DOl og andre
opplysninger i referansen. Man kan ogsa gjgre oppslag i Oria, med OpenURL Link. Dette krever
registrering av HVLs OpenURL-server:

1) Gatil EndNote X8 - Preferences... 2 Find Full Text
2) |feltet OpenURL Path fgrer du inn:
http://openurl.bibsys.no/openurl

3) EZProxy-serveren settes inn i feltet Authenticate with: URL:
https://login.galanga.hvl.no/login?
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Change Case

EndNote™ Preferences

Display Fields The Find Full Text feature uses several technologies to maximize the
Display Fonts chances that EndNote will find all available PDFs. Use this screen to control
Duplicates these full text search options.
Eind:Eull TexF Web of Science Full Text Links
Folder Locations
Formatting DO (Digital Object Identifier)
Libgaries. PubMed LinkOut (U.S. National Library of Medicine)
PDF Handling
Read / Unread OpenURL
Reference Types
Sorting lopenurL Path: | |
Sync
Temporary Citations Authenticate with:
Term LlSt.S [URL: I II
URLs & Links
Examples: https://login.ezproxy.library.myuniversity.edu/login
http://auth.universityname.edu/authentication
Automatically invoke Find Full Text on newly-imported references
[ EndNote Defaults J [ Revert Panel ]
. . o e .
Marker referansene du gnsker fulltekst til, og klikk pa Find Full Text: Fullteksten som blir funnet

pa nett blir na lastet ned og knyttet til referansen i biblioteket. Referanser med fulltekst er merket
med binders-ikon.

Synkroniser biblioteket med EndNote Online

Du kan synkronisere EndNote-biblioteket med en online-konto via Sync funksjonen. Dette gjgr det
lettere 3 fa tilgang til biblioteket fra andre datamaskiner, og du kan jobbe med biblioteket hvor og
nar du vil, sa lenge du har tilgang til internett. Du kan enten opprette konto for EndNote Online

pa siden https://myendnoteweb.com, eller ved a klikke pa Sync C Om du setter opp andre
datamaskiner til & synkronisere mot den samme kontoen, vil de kunne benytte samme bibliotek.
Biblioteket er ogsa tilgjengelig i EndNote Online.

For mer informasjon om EndNote Online, se «kKom i gang med Endnote Online» pa bibliotekets
EndNote-hjelpesider.

Del biblioteket

| EndNote Desktop kan du dele et helt bibliotek, og kun ett. Klikk File = Share (eller Share Library

k). Om du ikke har satt opp synkronisering, tar EndNote deg f@rst giennom denne prosessen. For 3
dele biblioteket, fgrer du inn epost-adressene for samarbeidspartnerne i det midterste feltet i
Sharing-vinduet (Invite More People). Klikk Invite, sa blir det sendt delingsinvitasjoner pa epost.
Mottakerne far en lenke til EndNote Online, og etter a ha logget seg inn, vil de finne igjen det delte
biblioteket i EndNote under File > Open Shared Library..., forutsatt at EndNote er synkronisert til
den samme kontoen.
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Om du ikke finner gnsket referansestil i EndNote stilsamlingen

Last ned referansestiler

Det finnes en rekke forskjellige stiler til nedlasting pa EndNotes nettsider. Du kan ogsa finne norske

referansestiler pa nettsidene til hgyskole- og universitetsbibliotek i Norge.

Har du lastet ned en referansestil fra nett, installerer du ved a apne filen, og deretter lagre den: File

- Save As... Velg et navn for stilen og klikk Save.

Se lenkene under «Referansestiler» pa bibliotekets EndNote-hjelpesider for referansestiler tilpasset

for HVL.

Redigering av eksisterende referansestiler

Vil du tilpasse en referansestil, f.eks. endre forkortelser, er det enklest & redigere en eksisterende stil.

1) Ga til Edit = Output Styles > Open Style Manager...

| oversiktslisten av stiler kan du krysse av stilene som vises i stiimenyen i EndNote og Word.

2) Marker stilen du gnsker a redigere og klikk Edit
3) Tilpass det du gnsker og avslutt med File - Save As...

Noen vanlige redigeringsmuligheter:

= Velg om tidsskrifttittel skal forkortes:
Journal Names
= Bytte ut engelske mot norske forkortelser i referansehenvisning:
Citations - Author Lists
=  Bytte ut engelske mot norske forkortelser for sidetall:
Citations > Templates: erstatt «p.» med «s.»
Bibliography - Templates: erstatt «p.» med «s.»

= Det meste av stilen er definert under Bibliography > Templates. Her er det definert hvilke
EndNote-felt som skal vises for de forskjellige referansetypene i litteraturlisten. Skal du

redigere noe her, bgr du veere veldig ngyaktig med tegnsettingen for a fa en feilfri
referansestil! For a legge til et nytt felt, klikk pa Insert Field og velg aktuell felt.

14


http://endnote.com/downloads/styles

Andre nyttige funksjoner i EndNote

Quick Search

Du kan bruke funksjonen «Quick Search» for a finne fort frem til en bestemt referanse i biblioteket.

EB [ Q_ Search Library

PDF-redigering

Det er mulig redigere PDF-filer knyttet til referanser i EndNote, f.eks. markere eller understreke
tekstpassasjer, legge til notater, etc.

Tittelregister for tidsskrifter

Noen databaser eksporterer referanser med forkortet tidsskrifttittel, og noen referansestiler krever
full tittel — og omvendt. EndNote kan oversette mellom kort og fullstendig tittel, og kommer med
ferdige tittelregistre for ulike fagomrader:

1) Gatil Tools 2 Open Term Lists 2 Journal Term List

2) Marker alle termer i listen og klikk pa Delete Term

3) Bytt til fanen Lists og klikk pa Import List...

4) Velg en aktuell liste (bare én) og klikk Choose for a importere listen

= Skulle du ikke automatisk komme til EndNotes termliste nar du klikker pa Import List...,
sa finner du listen under Applications > EndNote - Terms

Importer referanser fra PDF

EndNote har en funksjon for a importere referanser basert pa fulltekstartikler i PDF-format. Dette vil
som regel bare fungere for nyere PDF-er med DOI.

= |mport av en enkelt PDF-fil:

1) Gatil File = Import...

2) Under Options og Import Options, velg PDF File or Folder
3) Finn frem mappen eller PDF-filen du vil importere

4) Klikk pa Import
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